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Аннотация 
 

Рассмотрен расчет критических частот ротора методом конечных элементов с 
использованием пакета ANSYS на основе объемной, оболочечной, гармонической и 
стержневой моделей. Даны индивидуальные задания для лабораторных работ.  

Учебное пособие предназначено для студентов двигателестроительных факультетов, 
обучающихся по специальности "Авиационные двигатели и энергетические установки". 
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Введение 
 

Знание критических частот вращения ротора очень важно для обеспечения вибрационной 
прочности авиационных газотурбинных двигателей (ГТД). В современной практике 
конструирования для расчета критических частот вращения ротора применяется метод 
конечных элементов и основанные на нем пакеты программ, в частности, ANSYS. Основываясь 
на знаниях, полученных при изучении пакета ANSYS, курсов по основам метода конечных 
элементов, по динамике и прочности авиационных ГТД, студент может построить 
конечноэлементные модели ротора, рассчитать его критические частоты вращения и 
исследовать влияние на эти частоты различных параметров конструкции ротора. Применение 
различных типов конечных элементов (объемных, оболочечных, стержневых, гармонических) 
способствует как более глубокому пониманию метода конечных элементов и пакета программ 
ANSYS, так и повышению точности расчетов.  
 
 
 



Задание 
 

1. Построить объёмную, оболочечную, гармоническую и стержневую конечно-элементные 
модели ротора и рассчитать его первую и вторую критические частоты вращения. Варианты 
геометрических параметров ротора заданы в Приложении. Пример задания приведен на рис.1. 
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Рис.1. Пример варианта геометрических параметров ротора 

 
2. Описывается построение геометрии модели, применяемые конечные элементы. 

Приводится программа макроса. Приводятся собственные частоты первой и второй изгибных 
форм колебаний и сами формы. При выводе форм ротор располагается в плоскости OXY. 
Выполняется расчёт собственных частот ротора с недеформированными рабочими колёсами. 
При расчёте модуль упругости дисков и лопаток ротора принимается равным 2∙1015Па. Также 
приводятся собственные частоты первой и второй изгибных форм колебаний и сами формы. 
Делается вывод о влиянии податливости опор на величины критических частот вращения. 

3. Провести исследование влияния на критические частоты вращения ротора жёсткости 
его отдельных участков. Исследование проводится с помощью гармоничной или стержневой 
модели. Жёсткости проставок и носков вала изменяются за счёт увеличения или уменьшения их 
толщин. Расчёты выполняются для двух увеличений толщины каждой проставки или носка вала 
отдельно  
(∆h1 = 2мм, ∆h2 = 4мм). Результаты расчёта оформляются в виде графика (рис.2): 
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Рис. 2. Графики зависимости резонансной частоты от толщины проставок 

 
4. На основании полученных результатов выполнить частотную отстройку вверх на 5% с 

минимальным изменением массы ротора. Отстройка сначала выполняется для стержневой или 
гармонической модели, а затем проверяется для объёмной модели. Делается вывод о 
достигнутых результатах. Провести исследование влияния на критические частоты вращения 
ротора жёсткости дисков рабочих колёс. 

 



 

 

1. ОБЪЕМНОЕ МОДЕЛИРОВАНИЕ РОТОРА 
 
1. Построить ключевые точки, определяющие поперечное сечение ротора. Координаты взять 

из  
таблицы 1. 
 

Таблица 1 
Координаты ключевых точек для построения поперечного сечения ротора 

 
 
2. Построить поверхности по ключевым точкам. Номера ключевых точек для каждой 

поверхности приведены в табл. 2. 
 

Таблица 2 
Номера ключевых точек для построения поверхностей, составляющих поперечное сечение ротора 



 

 

 
 
3. Построить две ключевые точки, определяющие положение оси ротора: 

К,51,-0.3878,0,0 
К,52,0.5253,0,0 

4. Выбрать два типа конечных элементов: 
4.1. PrPr →Element type→Add/Edit/Delete→Add; 
4.2. Выбрать в левом окне shell; 
4.3. Выбрать в правом окне Elastic 4 node 3 и нажать Apply; 
4.4. Выбрать в левом окне Solid; 
4.5. Выбрать в правом окне Brick 8 node 45 и нажать Ok; 
4.6. Нажать Close. 

5. Задать свойства материала опор: 
5.1. PrPr →Material Props →Isotropic; 
5.2. Задать номер материала, равным 1; 
5.3. Нажать Ok; 
5.4.           Задать EX = 2 ∙ 1011 ПА; DENS = 7600кг/м3; NUXY = 0.3; 
5.5. Нажать Apply; 
5.6. Задать свойства материала номер 2 диска компрессора: 

3.0NUXY;мкг4500DENS;Па102.1EX 311 ==⋅= ; 
5.7.           Нажать Apply; 
5.8. Задать свойства материала номер 3 носка вала компрессора: 

3.0NUXY;мкг4500DENS;Па102.1EX 311 ==⋅= ; 
5.9.           Нажать Apply; 
5.10.          Задать свойства материала номер 4 диска турбины: 

3.0NUXY;мкг8000DENS;Па102EX 311 ==⋅= ; 
5.11.         Нажать Apply; 
5.12. Задать свойства материала номер 5 носка вала турбины: 

3.0NUXY;мкг8100DENS;Па102EX 311 ==⋅= ; 
5.13.  Нажать Apply; 
5.14. Задать свойства материала номер 6 проставки меньшего диаметра: 



 

 

3.0NUXY;мкг7800DENS;Па102EX 311 ==⋅= ; 
5.15.         Нажать Apply; 
5.16. Задать свойства материала номер 7 проставки большего диаметра: 

3.0NUXY;мкг7800DENS;Па102EX 311 ==⋅= ; 
5.17.         Нажать Ok. 

6. Задать атрибуты для оболочечных конечных элементов: 
6.1. PrPr →Real Constants →Add →Type 1 shell 63→Ok; 
6.2. Задать TK(I)=0.001; 
6.3. Нажать Ok; 
6.4. Нажать Close. 

7. Задать для каждой из линий построенной модели количество рёбер конечных элементов, 
которые будут сгенерированы в сечении ротора: 
7.1. Задать в соответствии с рис. 3 количество рёбер элементов для линий опор; 
 

 
Рис. 3. Количество рёбер конечных элементов в линиях опор 

 
7.2. Задать в соответствии с рис. 4 количество рёбер элементов для линий сечения диска 

компрессора; 
 

 
Рис. 4. Количество рёбер конечных элементов в линиях диска компрессора 

 



 

 

7.3. Задать в соответствии с рис. 5 количество рёбер элементов для линий сечений 
проставок; 
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Рис. 5. Количество рёбер конечных элементов на линиях проставок 

 
7.4. Задать в соответствии с рис. 6 количество рёбер элементов для линий сечения диска 

турбины; 
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Рис. 6. Количество рёбер конечных элементов на линиях сечения диска турбины 
 

8. Объединить в соответствии с рис. 8 линии оператором Concatenate: 
8.1. PrPr →Concatenate →Lines; 
8.2. Выбрать линии группы С1; 
8.3. Нажать Apply; 
8.4. Выбрать линии группы С2; 
8.5. Нажать Apply; 
8.6. Выбрать линии группы С3; 
8.7. Нажать Apply; 
8.8. Выбрать линии группы С4; 
8.9. Нажать Apply; 
8.10.         Выбрать линии группы С5; 
8.11. Нажать Apply; 



 

 

8.12. Выбрать линии группы С6; 
8.13. Нажать Apply; 
8.14. Выбрать линии группы С7; 
8.15. Нажать Ok. 

9. Сгенерировать сетку конечных элементов: 
PrPr →Mesh →Areas →Mapped →By Corners 3 or 4 side →Pick all. 

 
Рис. 7. Плоская КЭ модель ротора 

 
10. Уничтожить объединение линий, выполненное оператором Concatenate: 

PrPr →Concatenate →Del Concats →Lines. 
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Рис. 8. Объединение линий оператором Concatenate 

 
11. Создать объёмную геометрическую конечно-элементную модель ротора вращением 

сечения вокруг оси двигателя: 



 

 

11.1. PrPr →Operate →Extrude/Sweep; 
11.2. Elem Ext Opts; 
11.3. Задать для передней опоры номер материала Mat равным 1; 
11.4. Задать число конечных элементов по четверти окружности ротора VAL1 

равным 7; 
11.5. Обеспечить уничтожение оболочечных конечных элементов, поставив YES в 

окне Aclear; 
11.6. Нажать Ok; 
11.7. Выбрать About Axis в разделе меню Areas; 
11.8. Выбрать курсором поверхности сечений опор и нажать Ok; 
11.9. Выбрать ключевые точки KP51 и KP52, определяющие ось вращения и нажать 

Ok; 
11.10.       Задать угол поворота сечений равным 3600; 
11.11. Нажать Ok; 
11.12. Выполнить аналогичные операции для дисков, носков вала и проставок ротора. 
 

 
Рис. 9. Объёмная КЭ модель ротора 

 
12. Построить лопатки компрессора и турбины: 

12.1. PrPr →Create →Block by Dimensions; 
12.2. Задать: X1=-0.2578, X2=-0.2078, Y1=0.2662, Y2=0.3662, Z1=-0.003, Z2=0.003; 
12.3. Нажать Apply; 
12.4. Задать: X1=0.2654, X2=0.3454, Y1=0.2662, Y2=0.3862, Z1=-0.004, Z2=0.004; 
12.5. Нажать Ok. 

13.        Задать в соответствии с рисунком 8 количество рёбер элементов на линиях объёма 
лопатки компрессора. С помощью команды PrPr →Attributes →Define объёму лопатки 
компрессора материал диска компрессора. 

14. Сгенерировать сетку объёмных конечных элементов в теле лопатки. 
15. Совместить систему координат рабочей плоскости с глобальной прямоугольной системой 

координат: 
UM →Workplane →Align WP with →Global Cartesian. 
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Рис.10. Количество рёбер конечных элементов на линиях объёмов лопаток компрессора и турбины 

 
16. Развернуть систему координат рабочей плоскости таким образом, чтобы ось Х была 

радиальной, а ось Z совпадала с осью ротора: 
16.1. UM →Workplane →Offset WP by Increments; 
16.2. Установить шаг измерения угла равным 900; 
16.3. Повернуть систему координат рабочей плоскости относительно оси Z на угол 

+900; 
16.4. Повернуть систему координат рабочей плоскости относительно оси Х на угол -

900; 
17. Создать локальную цилиндрическую систему координат №11, оси которой совпадают с 

осями координат рабочей плоскости: 
17.1. UM →Workplane →Local Coordinate System→Create Local CS →At WP Origin; 
17.2. Задать: KCN=11, KCS=Cylindrical 1; 
17.3. Нажать Ok. 

18. Сделать локальную систему координат №11 активной. 
19. Создать четыре копии конечно-элементной модели лопатки, смещённые друг 

относительно друга по окружности на угол 900: 
19.1. PrPr →Copy →Volumes; 
19.2. Выбрать объём лопатки и нажать на Ok; 
19.3. Задать ITIME=4, DY=90; 
19.4. В окне NOELEM выбрать Volume and mesh; 
19.5. Нажать Ok. 

20. Связать лопатки и диск компрессора: 
20.1. Оператором Select Entities выбрать объём рабочего колеса компрессора; 
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Рис. 11. Выбор геометрии операцией Select 

 
20.2. Вывести на экран объём рабочего колеса; 
20.3. В меню Pan/Zoom/Rotate выбрать вид слева; 
20.4. Установить в меню Select Entities параметры Elements, Attached to, Volumes, 

Reselect и нажать Apply; 
20.5. Вывести на экран конечно-элементную модель колеса; 
20.6. Установить в меню Select Entities параметры Elements, By Num/Pick, Reselect и 

нажать Apply; 
20.7. Рамкой выбрать по два конечных элемента, контактирующих с каждой из 

четырёх лопаток и после выбора восьми элементов нажать Ok (см рис. 10); 
 

 
Рис. 12. Выбор конечных элементов для связи диска с лопатками 

 
20.8. Вывести на экран объём колеса; 
20.9. Установить в меню Select Entities параметры Volumes, By Num/Pick, Reselect и 

нажать Apply; 
20.10.       Выбрать курсором четыре лопатки колеса и нажать Ok; 
20.11. Установить в меню Select Entities параметры Areas, Attached to, Volumes, 

Reselect и нажать Apply; 
20.12. Установить в меню Select Entities параметры Areas, By Num/Pick, Reselect и 



 

 

нажать Apply; 
20.13. Рамкой Circle охватить сечения всех четырёх лопаток, по которым они 

контактируют с диском, и нажать Ok; 
20.14. Установить в меню Select Entities параметры Nodes, Attached to, Areas all, 

Reselect и нажать Apply; 
20.15. Вывести на экран узлы модели и убедиться, что присутствуют только узлы 

втулочных сечений лопаток; 
20.16. PrPr →Coupling/Ceqn→Adjacent Region; 
20.17. Установить допуск TOLER=0.25 (25%); 
20.18. Нажать Ok; 
20.19. Выбрать оператором Select Entities все узлы конструкции. 
 

 
Рис. 13. Модель закрепления лопатки с диском компрессора 

 
21.       Задать в соответствии с рисунком 8 количество рёбер элементов на линиях объёма 

лопатки турбины. 
22. Сгенерировать сетку объёмных конечных элементов в теле лопатки турбины. 
23. Создать четыре копии конечно-элементной модели лопатки турбины, смещённых друг 

относительно       друга по окружности на угол 900. 
24. Связать лопатки и диск турбины. 
25. Смоделировать радиально-упорный подшипник передней опоры: 

CSYS,11 
FI=0 

*Do,J ,1,7*4 
NN1=NODE(KX(7),FI,KZ(7)) !Определение номера узла по координатам! 

NN2=NODE(KX(4),FI,KZ(4)) 
NROTAT,NN1 !Совмещение узловой системы координат с активной СК! 
NROTAT,NN2 ! PrPr →Move/Modify→Rotate Node CS →To active CS ! 

CP,J ,UX,NN1,NN2 
CP,J+7*4,UZ,NN1,NN2 

FI=FI+90/7 
*Enddo 

 



 

 

 
Рис. 14. Модель РУП передней опоры 

 
26.       Смоделировать радиальный подшипник задней опоры (так же как в предыдущем 

пункте, но связать узлы только по перемещению UX). 
27. Закрепить опоры, задав нулевые смещения для узлов их периферийных поверхностей. 
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Рис. 15. Моделирования граничных условий заделки в опорах ротора 

 

 
Рис.16. Объемная КЭ модель ротора с лопатками 



 

 

 



 

 

2. ОБОЛОЧЕЧНОЕ МОДЕЛИРОВАНИЕ РОТОРА 
 
1. Вывести на экран 52 ключевые точки, определяющие геометрию поперечного сечения 

ротора и положение его оси. 
2.   Построить ключевые точки посередине между следующими парами точек: 

1 и 2, 3 и 4, 5 и 6, 7 и 8, 9 и 10, 14 и 15, 10 и 58, 12 и 13, 
22 и 24, 23 и 25, 20 и 21, 61 и 62, 19 и 18, 17 и 16. 

3. Построить по координатам KX(63), KY(65), KY(66) ключевые точки 67 и 68: 
K,67,KX(63),KY(65),0 
K,68,KX(63),KY(66),0 

4. Построить ключевые точки посередине между следующими парами точек: 
26 и 28, 27 и 31, 69 и 70, 29 и 30, 41 и 42, 34 и 35, 36 и 37, 
39 и 40, 43 и 44, 45 и 47, 46 и 48, 49 и 50, 38 и 75, 32 и 74. 

5. Построить между ключевыми точками 74 и 75 три новые ключевые точки, делящие 
расстояние между точками 74 и 75 на четыре равных отрезка: 
5.1. PrPr →Create →Keypoints →Fill between KPs; 
5.2. Выбрать курсором точки 74 и 75 и нажать на Ok; 
5.3. Задать число образованных точек NFILL равным 3; 
5.4. Задать число первой создаваемой ключевой точки NSTRT равным 83; 
5.5. Задать шаг изменённых номеров создаваемых ключевых точек NINC равным 1. 

6. Построить ключевые точки по координатам существующих ключевых точек: 
K,87,KX(73),KY(38),0 
K,88,KX(73),KY(81),0 
K,89,KX(73),KY(75),0 
K,90,KX(73),KY(85),0 
K,91,KX(73),KY(84),0 
K,92,KX(73),KY(83),0 
K,93,KX(73),KY(74),0 
K,94,KX(73),KY(82),0 
K,95,KX(73),KY(32),0 
K,96,KX(73),KY(76),0 

7. Соединить прямыми линиями следующие пары ключевых точек: 53 и 54, 54 и 55, 56 и 57, 
57 и 10, 10 и 59, 59 и 58, 59 и 60, 60 и 68, 68 и 66, 68 и 67, 67 и 65, 67 и 63, 63 и 64, 64 и 61, 
64 и 62, 65 и 74, 66 и 75, 75 и 89, 74 и 94, 90 и 91, 91 и 92, 92 и 94, 94 и 93, 93 и 95, 95 и 72, 
72 и 71, 69 и 71, 71 и 70, 90 и 89, 89 и 88, 88 и 87, 87 и 96, 96 и 73, 96 и 76, 76 и 77, 78 и 79, 
79 и 80. 

8.   Вращением линий построить оболочечную модель ротора: 
8.1. PrPr →Operate →Extrude/Sweep →Lines →About Axis; 
8.2. Выбрать курсором линию 1 и нажать на Ok; 
8.3. Выбрать курсором точки, определяющие ось вращения, и нажать Ok; 
8.4. Задать длину дуги в градусах ARC, равной 3600 и нажать Ok; 
8.5. Скопировать операторы построения поверхности в программу; 
8.6. На базе скопированных операторов создать следующий цикл команд для построения 

оболочечной модели ротора: 
*Do,J ,1,37 
FLST,8,2,3 

FITEM,8,51 
FITEM,8,52 

AROTAT,J ,,,,,,P51X,,360 



 

 

*Enddo 
9. Выбрать элемент Shell 63. 
10. По аналогии с объёмным моделированием задать характеристики материала для всех 

элементов ротора. 
11. Задать атрибуты для оболочек опор: 

11.1.         Вывести на экран ключевые точки, определяющие сечение передней опоры; 
11.2. Построить по ключевым точкам 1, 4 и 2, 3 две прямые линии; 
11.3. Построить перпендикуляр к этим двум линиям: 

11.3.1. PrPr →Create →Lines →Norm to 2 lines; 
11.3.2. Выбрать курсором обе построенных линии и нажать Ok; 

11.4.         Определить длину перпендикуляра ( )013765.0h1 = ; 
11.5.         Определить расстояние между точками 3 и 4 ( )0153.0h2 = ; 
11.6. PrPr →Real Constants →Add →Ok; 
11.7. Задать номер констант равным 1; 
11.8. Задать толщину TK(I) равной 0.013765; 
11.9. Нажать Apply; 
11.10.       Задать номер констант равным 2; 
11.11. Задать толщину TK(I) равной 0.0153; 
11.12. Нажать Ok; 
11.13. Нажать Close. 

Копировать в программу можно только оператор, начинающихся с буквы R. 
12. Задать атрибуты N3 для оболочки носка вала компрессора: 

12.1.          Определить расстояние между точками 7 и 8 (h3 = 0.015); 
12.2. Задать для атрибутов N3 толщину TK(I) равной 0.015. Атрибуты задать 

непосредственно в программе. 
13. Задать атрибуты N4 для оболочек ступицы: 

13.1.         Определить расстояние между точками 9 и 11 (h 4 = 0.03); 
13.2. Задать для атрибутов N4 толщину TK(I) равной 0.03. 

14. Задать атрибуты N5 для полотна диска компрессора: 
14.1.         Определить расстояние между точками 12 и 13 (h 5 = 0.015); 
14.2. Задать для атрибутов N5 толщину TK(I) равной 0.015. 

15. Задать атрибуты N6 для обода диска компрессора: 
15.1.         Определить расстояние между точками 22 и 24 (h 6 = 0.015); 
15.2. Задать для атрибутов N6 толщину TK(I) равной 0.015. 

16. Задать атрибуты N7 для проставки меньшего диаметра: 
16.1.         Определить расстояние между точками 16 и 17 (h 7 = 0.005); 
16.2. Задать для атрибутов N7 толщину TK(I) равной 0.005. 

17. Задать атрибуты N8 для проставок большего диаметра: 
17.1.         Определить расстояние между точками 18 и 19 (h 8 = 0.005); 
17.2. Задать для атрибутов N8 толщину TK(I) равной 0.005. 

18. Задать атрибуты для оболочки диска турбины в соответствии с рисунком 12: 
18.1.         Определить расстояние между точками 41 и 42 (h 9 = 0.1); 
18.2. Задать для поверхностей А1 м А2 в атрибутах №9 толщину TK(I) равную 0.1; 
18.3.         Определить расстояние между ключевыми точками 38, 87 (h 10 = 2×0.05 = 0.1) 

и 81, 88 (h 11 = 2×0.47725); 
18.4. Задать для поверхности А3 в атрибутах №10 толщины TK(I)=2x0.047725, 

TK(Y)=0.1, TK(K)=0.1, TK(L)=2x0.047725; 
18.5. Задать атрибуты для остальных поверхностей диска турбины. 



 

 

19. Задать атрибуты для носка вала турбины. 
20. Задать свойства материала №8 для недеформируемых участков ротора: 

3.0,0,Па102Е 11 ==⋅= µρ . 
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Рис. 17. Оболочечное моделирование диска турбины 

 
21. PrPr →Numbering Ctrls →Merge Items →All →Ok. 
22.  Построить конечно-элементную модель передней опоры: 

22.1.         UM →Select →Entities; 
22.2. Выбрать: Areas, By Num/Pick; 
22.3. Нажать Apply; 
22.4. Ввести в окно меню Ansys Input через запятую номера поверхностей; 
22.5. Нажать Enter на клавиатуре; 
22.6. Нажать Ok в меню Select Areas; 
22.7. Выбрать в меню Select Entities: Lines, Attached to, Areas; 
22.8. Нажать Ok; 
22.9. Вывести на экран изображение линий; 
22.10.      Задать на всех дугах по семь рёбер, на образующих конических поверхностей 

по четыре ребра и            на образующих цилиндрической оболочки по три ребра 
конечных элементов; 

22.11. Присвоить поверхностям А1, А2, А3 и А4 атрибуты с материалами №1 и 



 

 

реальными константами №1; 
22.12. Присвоить поверхностям А5, А6, А7 и А8 атрибуты с материалом №1 и 

реальными константами №2; 
22.13. Сгенерировать в поверхностях А1…А8 регулярную сетку коечных элементов. 

23. Построить конечно-элементную модель носка вала компрессора: 
23.1.         Операцией Select выбрать поверхности А9…А16 и связанные с ними линии; 
23.2. Задать на радиальных линиях по одному ребру и на всех других по семь рёбер 

конечных элементов; 
23.3. Присвоить поверхностям А9…А12 атрибуты с материалом №3 и реальными 

константами №3; 
23.4. Присвоить поверхностям А13…А16 атрибуты с материалом №8 и реальными 

константами №3; 
23.5. Сгенерировать в поверхностях А9…А16 сетку конечных элементов. 

24. Построить конечно-элементную модель диска компрессора: 
24.1.         Операцией Select выбрать поверхности А17…А24 и связанные с ними линии 

ступицы диска; 
24.2. Задать на образующих линиях по два ребра и на всех других по семь рёбер 

конечных элементов; 
24.3. Присвоить поверхностям А17…А24 атрибуты с материалами №2 и реальными 

константами №4; 
24.4. Сгенерировать в поверхностях А17…А24 регулярную сетку конечных 

элементов; 
24.5. Операцией Select выбрать поверхности А25…А32, А37…А40, А45…А52, и 

связанные с ними линии полотна диска; 
24.6. Задать на линиях количество рёбер конечных элементов в соответствии с 

рисунком 13; 
24.7. Присвоить поверхностям диска атрибуты с материалами и реальными 

константами в соответствии с рисунком 13; 
24.8. Операцией Select выбрать поверхности А53…А60 и связанные с ними линии 

обода диска; 
24.9. Задать на дугах по семь рёбер и на остальных линиях по два ребра конечных 

элементов; 
24.10.      Присвоить поверхностям А53…А60 атрибуты с материалом №2 и реальными 

константами №6; 
24.11. Сгенерировать в оболочках обода сетку регулярных конечных элементов. 

25. Построить конечно-элементную модель проставки меньшего диаметра: 
25.1.         Операцией Select выбрать поверхности А33…А36, А65…А72 и связанные с 

ними линии; 
25.2. Задать на всех дугах по семь рёбер, на образующих линиях крайних оболочек 

по одному ребру и на образующих линиях средних оболочек по 10 рёбер конечных 
элементов; 
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Рис. 18. Сектор диска компрессора 

 
25.3.         Присвоить всем крайним оболочкам атрибуты с материалом №8, реальными 

константами №7 и всем средним оболочкам атрибуты с теми же реальными 
константами и материалом №6; 

25.4. Сгенерировать в оболочках проставок сетку регулярных конечных элементов. 
26. Построить конечно-элементную модель проставок большего диаметра, используя в 

атрибутах материал №7 и реальные константы №8 (А41…А44, А61…А64, А73…А76). 
27. Построить конечно-элементную модель диска турбины: 

27.1.         Операцией Select выбрать поверхности А105…А112 и связанные с ними 
линии; 

27.2. Задать на всех дугах по семь рёбер и на образующих линиях по два ребра 
конечных элементов; 

27.3. Присвоить поверхностям обода атрибуты с материалом №4 и реальными 
константами №19; 

27.4. Сгенерировать сетку регулярных конечных элементов; 
27.5. Операцией Select с помощью рамки polygon выбрать все поверхности полотна 

диска турбины; 
 



 

 

 
Рис. 19. Выделение геометрии операцией polygon 

 
27.6.          Задать на всех дугах по семь рёбер и на всех радиальных линиях по одному 

ребру конечных элементов; 
27.7.          Присвоить поверхностям полотна диска атрибуты в соответствии с рис. 20: 
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Рис.20. Сектор полотна диска турбины 

 
27.8.        Сгенерировать в поверхностях полотна диска турбины сетку регулярных 

конечных элементов. 
28. Создать конечно-элементную модель носка вала турбины (А133…А140). Оболочки, 

примыкающие к диску турбины, принять недеформированными (М5, R20). 
29.  Создать конечно-элементную модель задней опоры ротора (А141…А148, М1, R1, R2). 
30.  Создать конечно-элементные модели лопаток: 

30.1.        Построить ключевые точки в активной системе координат в соответствии с 
табл. 3: 

 
Таблица 3 

Координаты ключевых точек для построения моделей лопаток. 



 

 

 
 

30.2. Построить поверхности лопаток компрессора и турбины в соответствии с рис.21: 
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Рис.21. Оболочечные модели лопаток компрессора и турбины 

 
30.3.          Задать в соответствии с рисунком 21 количество рёбер конечных элементов 

на линиях поверхностей лопаток; 
30.4.          Создать реальные константы №21 для поверхностей лопаток компрессора с 

толщиной TK(I), равной 0.006, и реальные константы №22 для поверхностей лопаток 
турбины с толщиной TK(I), равной 0.008; 

30.5. Присвоить в соответствии с рисунком 21 атрибуты поверхности лопаток; 
30.6. Сгенерировать в поверхностях лопаток сетку конечных элементов; 
30.7. Так же, как при объёмном моделировании ротора, создать локальную 

цилиндрическую систему координат №11 и сделать её активной; 
30.8. Создать по четыре равномерно расположенные по окружности лопатки 

компрессора и турбины. 
31. Склеить лопатки с соответствующими дисками (уничтожить объединение линий 

операцией concatenate): 
31.1. PrPr →Numbering Ctrls →Merge Items; 
31.2. Выбрать в окне Label команду All и нажать Ok. 

32. Смоделировать радиально-упорный подшипник передней опоры. 
33. Смоделировать радиальный подшипник задней опоры. 
34.  Закрепить опоры. 
 



3. ГАРМОНИЧЕСКОЕ МОДЕЛИРОВАНИЕ РОТОРА 
 
1. Скопировать из макроса построения объёмной модели ротора операторы задания свойств 

материалов. 
2.   Выбрать для моделирования типы конечных элементов: 

2.1.           PrPr →Element type →Add/Edit/Delete →Add; 
2.2. Выбрать в левом окне Solid; 
2.3. Выбрать в правом окне Axi-har 8 node 83 и нажать Apply (Plane 83); 
2.4. Выбрать в правом окне Quad 8 node 82 и нажать Ok; 
2.5. Нажать Options; 
2.6. В поле К3 выбрать Plane strs w/thk и нажать Ok; 
2.7. Нажать close. 

3. Скопировать из макроса объёмной модели операторы построения поверхностей сечения 
ротора. 

4.   Построить поверхностные модели лопаток: 
4.1. Построить ключевые точки в активной системе координат: 

K,350,-0.2578,0.3662,0 
K,351,-0.2078,0.3662,0 
K,352,0.2654,0.3862,0 
K,353,0.3454,0.3862,0 

4.2. Построить по ключевым точкам 24, 350, 351, 25 и 26, 352, 353, 27 поверхности 
лопаток компрессора и турбины; 

 

 
Рис.22. Плоская модель ротора 

 
5. Задать по длинам лопаток по пять рёбер конечных элементов. 
6.   Скопировать из макроса объёмной модели операторы задания количества рёбер коечных 

элементов по линиям сечения ротора. 
7.   Развернуть модель ротора таким образом, чтобы ось Y глобальной прямоугольной 

системы координат стала осью симметрии системы (осью ротора): 
7.1.           Разместить в начало глобальной системы координат систему координат рабочей 

плоскости; 
7.2. Повернуть систему координат рабочей плоскости вокруг оси Z на угол 900; 
7.3. Создать в системе координат рабочей плоскости локальную цилиндрическую систему 

координат №11 и сделать её активной; 
7.4. PrPr →Move/Modify →Areas; 
7.5. Нажать Pick all; 
7.6. Задать угол поворота модели DY равным -900 и нажать Ok; 
7.7. С помощью меню Pan-Zoom-Rotate повернуть модель относительно оси Z на угол 900 

так, чтобы ось Y глобальной системы координат стала горизонтальной. 



8. Создать конечно-элементную модель ротора, используя, где это потребуется, оператор 
Concatenate: 
8.1.    PrPr →Real Constants →Add; 
8.2. Выбрать элемент Plane 82; 
8.3. Задать толщины лопаток ТНК равными 0.006х4. Здесь 0.006 - толщина одной 

лопатки, 4 - число лопаток. Если лопатка переменной толщины, то её модель строят в 
виде нескольких поверхностей, для каждой из которых задаются свои Real Constant; 

8.4. Нажать Apply; 
8.5. Задать номер констант равный 2 и значение толщины лопатки ТНК равное 0.008х4 и 

нажать Ok; 
8.6. Нажать close; 
8.7. PrPr →Attributes Define →Picked Areas; 
8.8. Выбрать поверхность лопатки компрессора; 
8.9. Задать номер материала равный 2, номер реальных постоянных равный 1, тип 

конечного элемента Plane 82 и нажать Apply; 
8.10.         Выбрать поверхность лопатки турбины; 
8.11. Заменить номер материала на 4 и номер реальных констант на 2; 
8.12. Присвоить атрибуты для всех остальных поверхностей ротора, задав везде тип 

конечного элемента Plane 83 и соответствующий номер материала; 
8.13. Сгенерировать регулярную сетку конечных элементов. 
 

9. Смоделировать радиально-упорный и радиальный подшипники: 
PrPr →Coupling/Ceqn →Couple DOFS. 

 

 
Рис.23. Моделирование подшипника 

 

 
Рис.24. Модели радиально-упорного подшипника и радиального подшипника передней и задней опор 

соответственно 
 

10. Закрепить опоры. 
11. При запуске на расчёт задать, что вычисления будут выполняться для форм колебаний с 

одним узловым диаметром: 
11.1.          Solution →Other →For Harmonic Elements; 
11.2. Задать число гармоник по окружности MODE равным 1 и нажать Ok. 
 



 
Рис.25. Гармоническая модель ротора 

 



4. СТЕРЖНЕВОЕ МОДЕЛИРОВАНИЕ РОТОРА 
 
1. Построить объёмную конечно-элементную модель. 
2.   Уничтожить конечно-элементные и объёмные модели передней и задней опор, носка вала 

компрессора, проставок, рабочего колеса турбины, носка вала турбины так, чтобы 
остались только конечно-элементная и объёмная модель диска с лопатками рабочего 
колеса компрессора. 

3. Вывести на экран ключевые точки модели и определить координату Х любой из 
ключевых точек, расположенных в местах контакта полотна диска с проставками 
( )2253.0−=Õ . 

4.   Сместить модель рабочего колеса в направлении оси Х. Величину смещения DX задать 
равной 0.2253: 
4.1. Сделать активной прямоугольную систему координат; 
4.2.  PrPr →Move/Modify →Volumes →Pick all; 
4.3.  Задать DX=0.225 и нажать Ok. 

5. Определить массу рабочего колеса и момент инерции относительно диаметра (ось Х или 
ось Y): 
5.1.  PrPr →Operate →Calc Geom Items →Of Volumes →Normal →Ok; 
5.2. Записать величину массы колеса TOTAL MASS ( )065.36m =  и момент инерции JYY 

( )7442.0J y = . 
6. Аналогичным образом построить объёмную и конечно-элементную модель рабочего 

колеса турбины без включения носка вала турбины. 
7. Определить координату Х любой из ключевых точек, расположенных на площадке 

контакта диска с носком вала (X = 0.3553). 
8.   Сместить модель рабочего колеса в направлении оси Х. Величину смещения DX задать 

равной -0.3553. 
9. Определить массу рабочего колеса турбины и его момент инерции относительно оси Y 

( )289.2JYY;92.110m == . 
10.  Определить жёсткость опор в направлении оси Y: 

10.1. Используя модель ротора, построить конечно-элементную модель передней опоры; 
10.2. Для исключения локального деформирования связать все узлы, принадлежащие 

кольцевому сечению опоры, в котором прикладывается сила для определения 
жёсткости: 

10.2.1. PrPr →Coupling/Ceqn →Couple DOFS; 
10.2.2. Выбрать рамкой Box все узлы кольцевого сечения опоры, в котором 

прикладывается сила (рис. 26) и нажать Ok; 
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Рис. 26. Выбор узлов опоры для связывания их перемещений 

 
10.2.3. В окне NSET задать единицу, в окне LAB выбрать UY и нажать Ok; 

10.3. Приложить в узле NUZ в направлении оси Y силу величиной FY = 106H; 
10.4. Запустить решатель и определить в узле NUZ перемещение UY; 
10.5. Определить жёсткость опоры: 

м
Н107

1012788.0
10

UY
FYC 10

4

6

y ⋅=
⋅

==
−

; 
11. Скопировать из макроса объёмного моделирования ротора операторы построения 

ключевых точек, определяющих продольное сечение модели. 
12.  Вывести на экран ключевые точки. 
13.  Построить ключевую точку №53, имеющую координаты: Х=КХ(10), Y=0, Z=0. 
14.  Построить ключевые точки 54 и 55 с координатами, указанными в табл. 4. 
 

Таблица 4 

  
 
15. Построить посередине между ключевыми точками 36 и 37 ключевую точку №100: 

KBET,36,37,100,RATI,0.5 
16. Построить ключевую точку №56, имеющую координаты: Х =КХ(100), Y=0, Z=0. 
17. Построить посередине между ключевыми точками 34 и 35 ключевую точку №101. 
18. Построить ключевую точку 57, имеющую координаты Х =КХ(101), Y=0.025, Z=0. 
19. Построить ключевую точку 58 с координатами Х =КХ(40), Y=0, Z=0. 
20. Соединить прямыми линиями ключевые точки 51 и 53, 54 и 56, 58 и 52, 55 и 57. 
21. Уничтожить все свободные, не связанные с построением прямых линий ключевые точки. 
22. Для моделирования передней опоры построить ключевую точку 59 с координатами:    Х 

=КХ(51), Y=L, Z=0 и ключевую точку 60 с координатами: Х =КХ(51), Y=0, Z=L. Здесь L - 
длина стержня, имитирующего опору. Принять, что L=0.03. 

23. Соединить точки 51, 59 и 51, 60 прямыми линиями. 
24. Аналогичные линии в горизонтальной и вертикальной плоскостях построить для задней 

опоры. 
25. Скопировать из макроса построения объёмной модели операторы задания характеристик 

материалов носков вала и проставок. 
26. Для конечно-элементного моделирования ротора выбрать три типа конечных элементов: 



26.1.          MASS →3D MASS 21 →Apply; 
26.2. LINK →3D SPAR 8 →Apply; 
26.3. PIPE →Elast straight 16 →Ok. 

27.  Задать число рёбер элементов по линиям модели в соответствии с рис.27. 
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Рис. 27. Задание чисел рёбер конечных элементов по линиям модели 

 
28. Задать реальные константы для носка вала компрессора (линия №1): 

28.1. PrPr →Real Constants →Add →Pipe 16 →Ok; 
28.2. Задать номер констант №1, наружный диаметр носка вала 16.008.02OD =×= , 

толщину стенки носка вала TKWALL=0.015; 
28.3. Нажать Apply. 

29. Задать реальные константы для проставки меньшего диаметра: 
29.1. Задать номер констант №2, наружный диаметр носка вала 2324.01162.02OD =×= , 

толщину стенки носка вала TKWALL=0.005; 
29.2. Нажать Apply. 

30. Задать реальные константы для проставки большего диаметра: 
30.1. Задать номер констант №3, наружный диаметр носка вала 4324.02162.02OD =×= , 

толщину стенки носка вала TKWALL=0.005; 
30.2. Нажать Apply. 

31. Задать реальные константы для носка вала турбины: 
31.1. Задать номер констант №4, наружный диаметр носка вала 1924.00962.02OD =×= , 

толщину стенки носка вала TKWALL=0.0196; 
31.2. Нажать Ok. 

32. Выполнить моделирование опор. 
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Рис. 28. Расчётная схема нагружения стержня, имитирующего податливую опору 

 
Опоры будем моделировать двумя стержнями, работающими только на 
растяжение/сжатие. Один из стержней будем располагать в горизонтальной плоскости, 
другой - в вертикальной. В соответствии с законом Гука удлинение стержня ∆l от 



действия силы Q определится формулой: 

FE
QLl

⋅
⋅

=∆
, 

где E - модуль упругости материала; 
      F  - площадь поперечного сечения. 
Из этой формулы находим: 

lCl
L

FEQ ∆⋅=∆⋅
⋅

=
, 

Здесь C - жёсткость стержня на растяжение. 
Если задать, что у стержней, имитирующих опоры, F=L, то жёсткость становится равной 
модулю упругости материала. 
32.1.          PrPr →Real Constants →Add →LINK 8 →Ok; 
32.2. Задать Set № 5, Area=L=0.03; 
32.3. Нажать Ok; 
32.4. Нажать close; 

32.5.          Задать материал №9 с 
3мкг0=ρ , мН1078.0СЕ 11⋅== ; 

33. Задать линиям модели атрибуты: 
33.1.          PrPr →Attributes Define →Picked Lines; 
33.2. Выбрать линии опор и нажать Ok; 
33.3. Задать материал №9, реальные константы №5, тип элемента Link 8; 
33.4. Нажать Apply; 
33.5. Выбрать линию №1 (носок вала компрессора) и нажать Ok; 
33.6. Задать материал №1, реальные константы №1, тип элемента Pipe 16 и нажать 

Apply; 
33.7. Выбрать линию №2 (проставка меньшего диаметра); 
33.8. Задать материал №6, реальные константы №2, тип элемента Pipe 16 и нажать 

Apply; 
33.9. Выбрать линию №4 (проставка большего диаметра); 
33.10.       Задать материал №7, реальные константы №3, тип элемента Pipe 16 и нажать 

Apply; 
33.11. Выбрать линию №3 (носок вала турбины) и нажать Ok; 
33.12. Задать материал №5, реальные константы №4, тип элемента Pipe 16 и нажать 

Ok. 
34. Сгенерировать конечные элементы. 
35. Закрепить по всем степеням свободы стержни опор. 
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Рис. 28. Моделирование граничных условий заделки для стержней опор 

 
36. Закрепить перемещения UX и ROTX в точке 51. 
37. Смоделировать рабочие колёса. Рабочие колёса будем моделировать сосредоточенными 



массами и уравнениями, связывающими перемещения узлов, принадлежащих 
недеформированному телу: 
37.1.         PrPr →Real Constants →Add →Mass 21 →Ok; 
37.2. Задать номер реальных констант №6; 
37.3. Задать MASSX=36.065, MASSY=36.065, MASSZ=36.065, JYY=0.7442, 

JZZ=0.7442; 
37.4. Нажать Apply; 
37.5. Задать номер реальных констант №7; 
37.6. Задать MASSX=110.92, MASSY=110.92, MASSZ=110.92, JYY=2.289, JZZ=2.289; 
37.7. PrPr →Create →Elements; 
37.8. Elem attributes; 
37.9. Задать Type=MASS 21, REAL=6; 
37.10.      Нажать Ok; 
37.11. Thru nodes; 
37.12. Выбрать узел, совпадающий с ключевой точкой №54, и нажать Ok; 
37.13. Elem attributes; 
37.14. Задать Type=MASS 21, REAL=7 и нажать Ok; 
37.15. Thru nodes; 
37.16. Выбрать узел, совпадающий с ключевой точкой №58, и нажать Ok; 
37.17. Определить номера узлов, совпадающих с ключевыми точками 53, 54, 55, 56, 57 

и 58; 
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Рис.29. Определение узлов стержней ротора для связывания перемещений 

 
37.18. Определить смещение по оси Х между точками 53 и 54 ( )0325.0х1 =∆ ; 
37.19. Определить смещение по оси Х между точками 56 и 58 ( )09555.0х2 =∆ ; 

37.20. Определить смещение по оси Х между точками 57 и 58 ( )0696.0х3 =∆ ; 
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Рис.30. Определение знаков перемещений для связанных узлов 

 
NXMX qq = ; NZNYMY xqq β⋅∆+= ; NYNZMZ xqq β⋅∆−= ; 

NXMX ββ = ; NYMY ββ = ; NZMZ ββ = ; 
0q1q1 NXMX =⋅−⋅ ; 0xq1q1 NZNYMY =⋅∆−⋅−⋅ β ; 0xq1q1 NYNZMZ =⋅∆+⋅−⋅ β ; 

011 NXMX =⋅−⋅ ββ ; 011 NYMY =⋅−⋅ ββ ; 011 NZMZ =⋅−⋅ ββ ; 
37.21. PrPr →Coupling/Ceqn →Constraint Eqn; 
37.22.  Задать: 

Apply;
-1;C2

UX;LAB2
7;NODE2

1;C1
UX;LAB1

2;NODE1
0;CONST

1;NEQN

=
=

=
=

=
=
=

=

 
37.23. Задать: 

Apply;
ROTX;LAB2
ROTX;LAB1

2;NEQN

=
=

=

 
37.24. Задать: 



Apply;
ROTY;LAB2
ROTY;LAB1

3;NEQN

=
=

=

 
37.25. Задать: 

Apply;
ROTZ;LAB2
ROTZ;LAB1
4;NEQN

=
=

=

 
37.26. Задать: 

Apply;
-0.0325;C3

ROTZ;LAB3
2;NODE3

UY;LAB2
UY;LAB1

5;NEQN

=
=

=
=
=

=

 
37.27. Задать: 

Ok;
0.0325;C3

ROTY;LAB3
UZ;LAB2
UZ;LAB1

6;NEQN

=
=
=
=

=

 
37.28. Аналогичные уравнения записать для узлов 24 и 7 ( )0x =∆ , 8 и 18 09555.0х =∆ , 25 

и 18 ( )0696.0х =∆ . 
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